
1Welcome to RCT’s Getting Started Manual
Congratulations on your decision to use Reyburn CyberTuner (RCT). 

This Getting Started Manual will teach you how to use RCT to tune pianos. 

After reading this Getting Started Manual, you may want to learn more about 
RCT. Here’s how:

Watch the RCT video tape or DVD, included with purchase. The video starts with 
the basics then goes into advanced details. You don’t need to watch it all in one 
sitting.

Use RCT’s on-line help, accessed by pulling down RCT’s Help menu or clicking      
the Help button in many of RCT’s windows. When running RCT, use On-Line help   
any time you need quick answers.

Refer to the RCT Reference Manual, which is very complete and has an index. 
This manual is in Acrobat PDF electronic format and is on the RCT CD installed 
in RCT’s folder on your computer. This manual is the best resource for learning 
everything about RCT’s full capabilities.

What is Reyburn CyberTuner and how does it work?
Reyburn CyberTuner is software that turns a computer into an easy-to-use yet 
extremely powerful piano tuning device. The two modules used for tuning pianos 
are Chameleon 3 (Ch3) and CyberEar (CE). 

RCT has additional capabilities and modules such as Pianalyzer, PTG Exam 
mode, Custom Equalizer, Preview Graphs, and more. These are not covered in 
this Getting Started Manual. See the RCT video and the RCT Reference Manual 
on the CD for information on these features.

Do this first
Install RCT from CD or SD card
1. Start your computer. Insert the RCT CD-ROM or SD card. (On Windows 
computers double click to open “My Computer” and double click to open the CD 
or SD card icon.)

2. Open the folder for your operating system, Windows or Macintosh. RCT 5.x 
only installs and runs on MacOS X or Windows 2000 and later. Open and read 
the RCT Read Me file (printing this file is highly recommended).

3. On both Mac and Windows Open “Install RCT 5”. On Mac, after the disk image 
opens, drag the “Reyburn CyberTuner 5” folder to the “Applications” folder.

4. Open the “WibuKeyInstall” and accept the default installation options.

5. After RCT is installed, attach the Wibu SentinelKey to the USB port. Normally 
there is no need to restart, only restart if there is a problem.

On Windows, open RCT from the desktop icon shortcut. On MacOS X open your 
hard drive, Applications, Reyburn CyberTuner 5 folder and open the RCT icon.

Wibu brand
SentinelKey

Install RCT 5

RCT 5.x CD
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2 If your computer is a laptop, you’ll be asked to install SoftKey, which lets you run 
RCT without SentinelKey attached. You do, so click the Install button.

Quit RCT, remove SentinelKey and put it back in its plastic pouch and white or 
clear box. On SentinelKey’s box, write down the computer onto which SoftKey 
installed and SentinelKey is locked.

Store SentinelKey in a safe place. If you lose SentinelKey, you’ll need to 
repurchase RCT at full price.
You may install RCT onto as many computers as you like, but SentinelKey and 
SoftKey let you run RCT on only one computer at a time. To uninstall SoftKey 
choose Edit menu, SoftKey, and click the Uninstall button. This allows you to 
move RCT to another computer. See the RCT Reference Manual for more 
details.

Calibrate your computer to A440
Included with your purchase of RCT is a CyberFork, an electronic metronome 
that outputs a tone at A440. Use the Cyberfork to calibrate your computer’s 
soundcard to A440. You only need to do this once. Detailed instructions are 
printed on a separate blue sheet and are on the Reyburn.com download page. 

Send in your registration card
To insure you’ll be eligible for free support and to receive update notices, fill out 
and mail in your RCT registration card.

Join CTuner

Registered owners of Pocket RCT and RCT (Mac and Windows) are eligible to 
join CTuner and RCTUPgrade. CTuner is a free email discussion group about 
Pocket RCT and RCT and where we post announcements of upgrade releases.. 
RCTUpgrade is for users who only want to receive notices of upgrade releases 
without any discussion. As a CTuner subscriber, any email you send to the 
CTuner list will automatically be sent to all other CTuner subscribers. Likewise, 
email from other CTuner subscribers will automatically be sent to you. To 
subscribe to CTuner or RCTUpgrade, see <www.reyburn.com/lists.html>. 
Watch the RCT “Mitch and Dean show” DVD
The 2.5 hour video of Dean and Mitch demonstrating RCT is a great way to learn 
about RCT. We show most essential RCT features including taking samples, 
tuning tips, saving files, and much more.

Make friends with the RCT Reference Manual and On-Line Help
The RCT Reference Manual has full and complete information about RCT. The 
RCT manual is a “.pdf” file that is loaded onto your hard disk when you install 
RCT. If the PDF manual doesn’t open on your computer you may need to 
download Acrobat Reader from www.adobe.com.

On-Line Help is available while running RCT and will provide quick answers to 
most of your questions. Click on a Help button in an RCT window or pull down 
RCT’s Help menu.

RCT Support
Despite all the resources already provided, you may have “emergency” questions Win       Mac
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about RCT. Free and unlimited support is available on our toll free phone 
number (in USA or Canada), but please check your documentation first. Contact 
information is listed at the end of this manual.

If you don’t get a live person when phoning, the fastest way to get an answer is to 
fill out our support web form at www.reyburn.com/support.html. The support web 
form is answered quickly even if we’re away from the phone.

If you have questions about your computer, operating system, or other non-RCT 
software, please contact the appropriate vendor or manufacturer. 

Tuning a piano
The two RCT modules that are used for tuning pianos are Chameleon and 
CyberEar. 

Chameleon measures and records five (or six) sample notes, then calculates a 
tuning record with the correct pitches for all 88 notes. 

CyberEar helps you tune each string to its correct pitch with a rotating Spinner as 
a visual aid. 

Easy Mode or Advanced Mode?
The first time you open RCT, Chameleon opens with Easy Mode automatically 
selected. To simplify the process of learning to use RCT, we recommend you use 
Easy Mode for at least twenty tunings. (Many experienced users stay in Easy 
Mode all the time.)

Easy Mode is called “easy” because it makes most tuning decisions for you, 
automatically creating a tuning that will sound great on almost all pianos.

Advanced Mode is for experienced and adventuresome tuners who want to 
customize the sound of their tunings by choosing other stretch styles and 
partials. Advanced Mode is described in this Getting Started Manual after we fully 
explain Easy Mode. If you’re using Easy Mode, you don’t need to read any of the 
Advanced Mode explanations.

To switch between Easy Mode and Advanced Mode, click on the Easy/Advanced 
switch in Chameleon.

Creating a tuning in Chameleon 3
To create a new tuning in Easy Mode
Start up your computer and open RCT. Set your computer on or near the piano: 
grands, on the plate struts; verticals, on top of the pinblock or on the fallboard or 
music shelf. (Suggestion: glue rubberized shelf liner to the laptop’s bottom.) 

RCT automatically opens to Chameleon . Click the Record button to begin 
sampling. 

A finger will point to the note you should play. Mute the unison so only one 
string is sounding and play the note. You’ll sample A4, A3, A2, A1, and A5 (A6 
if needed) three times each. Play each note with a consistent medium strength 
blow. Hold down the note while the rings pulse around the ear and let up when 
the tuning fork spins.



4 After playing A4 three times, the actual pitch of A4 will be displayed in either 
Hertz (e.g. 440.00) or cents from 440. (To switch, click on A4’s pitch reading.) 
This helps you know whether the piano needs a Fine Tuning or a Pitch 
Raise. Generally, if the piano is off by at least 2 Hertz or 8¢, a Pitch Raise is 
recommended. (More on Pitch Raising below.) 

When sampling notes to create a new tuning, the piano doesn’t 
need be in tune at correct pitch. However, it does need to be 
within 50¢, and Chameleon  will automatically tell you if it’s not. 
If it’s not, you can sample A# or tune the A string up (assuming 
the piano is flat) until sampling starts as indicated by the pulsing 
rings.

After each note is sampled three times, Good, Fair, or Poor will appear under 
the note, indicating the variance (consistency) of the note’s three samples. Good 
variance yields the most accurate tunings. Fair variance on one or two notes 
is OK. But if any note reads Poor, you should resample it by clicking on its key, 
tuning fork icon, or variance box. The ear will appear over the note, meaning 
its OK to play it. (To cancel a resample, click the Stop button.) Keep trying until 
you get Good or Fair variance. To improve Variance, try these tips: reduce 
extraneous noises, move the computer or mic an inch or two, point the mic at the 
soundboard, choose a cleaner-sounding string, play a short-sustaining note twice 
during sampling (especially A5, A6, or A1), or pluck the string.

Click the Calculate button. CyberEar will open and you’re ready to tune strings. 
(Although you didn’t see it happen, an 88-note tuning record was created when 
you clicked Calculate. Tuning records are more fully explained under Advanced 
Mode.)

Tuning the strings in CyberEar
CyberEar helps you tune the strings to the 88 pitches that Chameleon  
calculated.

When CyberEar first opens, note A0 will be selected, as indicated by the note 
name in the big box in the center and by the pointing finger on the graphic 
keyboard. (Another note such as A4 can be selected as default start note in 
CyberEar Prefs)

Spinner
CyberEar’s Spinner looks like a round pie with two opposite slices removed. 
The Spinner shows you if the selected note is sharp, flat, or correctly tuned. The 
Spinner rotates clockwise if the note is sharp and counterclockwise if flat, and 
moves to the right if the note is sharp and left if flat. The rotation and movement 
of the Spinner increases the more out of tune the note is. When a note is close 
to correct, the Spinner will be centered on the black Target and its rotation almost 
stopped. When the note is extremely close, the Spinner will stop rotating and a 
dim ball called the Blush will appear inside the Spinner. The Blush first appears 
at half the Spinner’s diameter and gets larger as the note gets even closer, until 
the Blush completely fills the Spinner when the note is virtually perfectly tuned. 

Hot tip!



5Generally, we recommend you try to get at least partial or temporary blush on all 
strings when Fine Tuning. The better the piano, the more discerning the client, 
and the more skillful the tuner, then the more you can try for maximum blush. 
But in reality, it’s impossible or impractical to tune all strings on all pianos to a full 
blush.

The first time you open CyberEar, the Spinner is set to rotate at 2¢ per revolution 
per second. Students may prefer a less sensitive Spinner rate of 4¢ or more. 
(The Blush sensitivity will automatically adjust too.) To adjust the Spinner rate, 
color, or arc size, click the Spinner button.

Note Switching
CyberEar’s NoteSwitcher “automagically” switches to the next chromatic note (up 
or down). Simply play an adjacent note and NoteSwitcher will switch to it.

NoteSwitcher hints
If NoteSwitcher has trouble auto-switching to the next note, play the note it’s 
stuck on then play the note you want to switch to.

To switch to a note several half steps distant, play a chromatic run. NoteSwitcher 
will follow along at about 3 notes per second.

You can also manually switch to any note. The easiest way is to press your 
computer keyboard’s arrow keys: up arrow for note up, down arrow for note 
down, left arrow for octave down, and right arrow for octave up. Hold down an 
arrow key for rapid continuous switching. (Switch speed rate can be adjusted in 
your operating system’s Control Panel.)

Other ways to manually switch notes are to press the space bar to switch up 
one note (hold down for continuous switching), click on any key on CyberEar’s 
graphic keyboard to immediately switch to it., or click on CyberEar’s navigation 
buttons, note-up, note-down, octave-up, octave down.

Note order and muting procedure
Most RCT users tune chromatically from A0 up to C8 because it’s quick, easy, 
and promotes tuning stability. Others begin with an aural temperament sequence 
you can instruct RCT to use (see RCT User manual). Many of us use two rubber 
mutes (or a split mute) and tune unisons as we go; others strip-mute the entire 
piano, tune a single string for all notes, then tune unisons.

It doesn’t much matter which order or muting method you use. However, it’s 
important that you listen to aural intervals during and, more importantly, after the 
tuning. This will help you make sure RCT did its normal great job and will help 
improve your aural skills. Pay special attention to the bass/treble break on short-
scale pianos (e.g., spinets, small grands, short consoles) where occasionally 
some notes may benefit from aural refinement.

Changing the pitch of a tuning
All RCT tunings are originally created in Equal Temperament at A-440. To tune 
a piano to any other pitch, in CyberEar hold down the mouse button over the 
pitch popup menu (located at CyberEar’s top center) and select a pitch in Hertz 
or, to offset the pitch in cents from 440 Hz, choose Other. To convert an Equal 
Temperament tuning to another temperament, please refer to your User Manual. 
The offset button can also be used to incrementally change the pitch.



6 After the piano is tuned
When you’re finished tuning the piano in CyberEar, click the Done button. If 
you were in Easy Mode, you’ll go back to Chameleon  and be ready to sample 
another piano.

When you quit RCT, you’ll be asked if you want to “Save changes to the Reyburn 
CyberTuner document “Untitled” before quitting RCT?” We recommend Easy 
Mode users don’t save tunings, so click Don’t Save. (To learn to save tunings 
and re-use them later, read “Saving Tuning Records and Files” in the Advanced 
section.)

Pitch Raising
Pitch raising (or lowering) with RCT is very accurate and fast because every 
note is automatically measured and overpulled using a customized overpull 
percentage optimized for each note. The first pitch raise pass usually leaves 
most notes within a cent or two, even for pitch raises of 50¢. 

We recommend you pitch raise if A4’s pitch (displayed immediately after 
sampling A4 in Chameleon ) is off by more than 8 cents or  2 Hz. For optimum 
accuracy, after pitch raising go back to Chameleon , re-sample and calculate 
another tuning, then return to CyberEar and do a Fine Tuning. 

To pitch raise with RCT
In Chameleon , click the Record button and record samples.

Click the Calculate button which takes you to CyberEar (Easy Mode). Hold down 
the mouse button over the Tuning Mode popup menu (which is probably set to 
Fine Tune) and select Pitch Raise. The Pitch Raise dialog box will open. (If Pitch 
Raise is already selected, reselect it.)

In the Pitch Raise dialog box, enter the piano’s lowest plain-wire note 
(unwrapped string) by pressing your computer’s up or down arrow keys.

Usually, the other settings in the Pitch Raise dialog box don’t need to be 
changed. See the RCT User Manual or video for more info.

If you’re starting a new pitch raise, click Start New. If you’re continuing a partially 
completed pitch raise, click OK. You’ll return to CE. 

If starting a new pitch raise, A0 will be selected. Play A0 and let it sustain while 
the Spinner fills in. In other words, don’t tune the string until the Spinner fills in 
completely. Then tune A0 normally so the Spinner stops rotating. 

 Play the next chromatic note up. NoteSwitcher will automatically switch and 
measure it, offsetting the Spinner’s black Target as needed.

Continue tuning chromatically up to C8, tuning each note’s unisons as you go.

After pitch raising is completed, click the Done button, which returns you to Ch3. 
Resample and create a new tuning record. Return to CyberEar, select Fine Tune 
mode, and retune as needed.



7Pitch Raising hints
Especially in the bass, watch out for Note-Switcher accidentally selecting 
the note a minor third below the note you want to tune. To help avoid this, 
set NoteSwitcher to up-only (press the U key). To reset NoteSwitcher to bi-
directional, press the B key. (For down-only, press the D key).  If the pitch raise 
is large, open the file named “chip tuning.rctx” which has a special tuning record 
optimized for large pitch raises.

If the next note (up a half step) is too flat for NoteSwitcher to correctly auto-
switch to, set NoteSwitcher to up-only or locked-off (press the L key to toggle 
NoteSwitcher on or off), manually switch up one note by pressing the computer’s 
space bar or the up arrow key, then play the selected note.

If a note’s measurement was poor (noise, incorrect note struck, etc.), press the E 
key to erase the highest sampled note, then reselect and re-measure it.

Don’t worry too much about getting a Blush when pitch raising, especially if the 
pitch raise is over 50¢.

Easy Mode users are done Getting Started!
Easy Mode users now know everything (well, almost everything) you 
need to know about RCT and don’t need to read any further in this Getting 
Started Manual. So put down this manual, pull up your socks, and go tune 
some pianos!-

Advanced Mode users—Read on....
Chameleon’s Advanced Mode
To change from Easy mode to Advanced mode, click on Chameleon’s Easy/
Advanced switch. More choices will appear, discussed below. (If you switch from 
Easy Mode to Advanced Mode, the Easy Mode default OTS 4 and Smart Partials 
will be selected.)

Advanced mode is different from Easy mode in that clicking the Calculate 
button creates a tuning record and displays its tuning chart. A tuning chart is a 
spreadsheet with pitches and partials for all 88 notes and is where you can name 
the tuning record if you want to save it (described below). To go from a tuning 
chart to CyberEar, click the CyberEar button or pull down the Windows menu to 
select CyberEar or press the Enter/Return key. 

Octave Tuning Styles
Ch3’s Advanced Mode lets you select from nine graduated levels of overall 
stretch ranging from very clean to very stretched. Each stretch style is called an 
Octave Tuning Style (OTS). The OTSes are arranged in groups of three: clean 
(1, 2, 3), standard (4, 5, 6), and stretched (7, 8, 9). 

:)



8 OTS 4 uses a stretch style similar to what most pro tuners (RCT and aural) use 
on most pianos, which is why OTS 4 is automatically selected in Easy Mode. We 
suggest Advanced Users use OTS 4 on a few pianos, listen to it, then decide if 
you prefer a different style. You may prefer a lesser stretched style such as OTS 
2 or 3, especially for low inharmonicity pianos such as Kawai and Yamaha. 

Higher-stretched styles such as OTS 5, 6, and sometimes 7 are often preferred 
for larger grands, especially a Steinway D in a concert hall. The tenth OTS is 
RPT Exam, which emulates a Master Tuning for PTG’s Tuning Exam (OTS 4 with 
less treble stretch).

OTS choice is subjective, critical listening is the best way to choose.

Octave Tuning Style beat rates are illustrated in this chart. For more detailed info, 
please see your User Manual.

B = Bass control octave (A2 to A3 6:3 octave)
T = Treble control octave (A3 to A4 4:2 octave)
A7 = lower note referenced, single, double or triple octave (1.0, 2.0, 3.0)
SOM-T = Treble control octave Single Octave Minimum
SOM-B = Bass control octave Single Octave Minimum
DMax = Double Octave Maximum (see Auto Compensation below)

Predicted Beat Rates
When a tuning record is created, the predicted beat rates for B (A2-A3 as a 6:3), 
T (A3-A4 as a 4:2), and D (A2-A4 as a 4:1) are automatically written into the 
tuning record’s header, displayed in its tuning chart, graph, file, and CyberEar. 
This allows you to “pre-listen” to the middle octaves (and know if DMax and SOM 
were invoked, see below).

Chameleon remembers the current set of A-note samples until 
you sample another piano, even if you quit RCT or turn off your 
computer. This means you can calculate many tunings for a piano 
(e.g., using different OTSes) without resampling. 

Partials
Advanced Mode lets you select different partials for various sections of the 
keyboard. Generally, the partials selected by Ch3’s “Smart Partials” feature 
sound great on almost all pianos, it is rare to find a piano which can be improved.

Hot tip!



9Chameleon allows advanced users to change partials, just uncheck the box next 
to “Smart Partials”. Click on a partial popup menu to see a list of available partials. 
The notes affected by that choice will be darkened on the graphic keyboard.

The ‘Smart Partials” feature will often choose partials 7 or 10 in the bass and 5 in 
the tenor. These partials may appear out of place in the graph window. They are 
non-octave partials and the math of equal temperament makes them offset. No 
need for concern, Smart Partials makes good partial choices on any size or type 
piano. Smart Partials gives more accurate stretch and a smoother bass-treble 
transition. The final test is to listen to the piano after tuning!

Chameleon will sometimes ask you for the piano’s size for after recording. It only 
displays the piano size dialog box if it detects a low inharmonicity piano. You can 
change the size later by clicking on the Size: button. The Size setting affects Ch3’s 
partial choice in the lowest octave.

Automatic compensation for short-scale pianos
Ch3 has two Limits (think of them as watchdogs) that help a lot when tuning “scale  
challenged” pianos such as spinets, short consoles, etc. 

In the fraction of a second after clicking the Calculate button and before a tuning 
record is created, DMax (Double Octave Maximum) and SOM (Single Octave 
Minimum) inspect every tuning record, automatically sense scaling problems 
and, as necessary, make an interactive series of compromises so each piano will 
sound its best.

Ch3’s Limits use a “thought process” that closely mimics aural techniques:

First, Ch3 tunes a two octave A2-A4 temperament using the chosen OTS’s stretch 
for single octaves A2-A3 and A3-A4.

DMax “listens” to the beat speed of the resultant double octave A2-A4. If it sounds 
good, the tuning record is created and the watchdogs go back to sleep. But if A2-
A4 is too wide, DMax narrows the single octaves until the double octave sounds 
OK.

Then SOM “listens” to the two single octaves A2-A3 and A3-A4. If they sound 
good, the tuning record is created and the watchdogs retreat to bed. But if the 
single octaves are too narrow, SOM (re)expands them until they sound OK, 
forcing the double octave to expand further than DMax prefers. 

RCT’s Limits are invoked only if a piano needs their help. Limits are not needed 
on most midsize pianos and never on well-scaled big grands and verticals. On 
some short-scale spinets and consoles, the A2-A4 double octave is narrowed 
by DMax and the single octaves still sound good, so SOM is not invoked. On 
problematical short-scale pianos with substantial scale inconsistencies (aka Piano 
Shaped Objects and less printable epithets) DMax and SOM are both used. You 
can tell when and which Limits have been used by looking at the Predicted Beat 
Rates and comparing them to an OTS’s standard specs. (For specific beat rate 
numbers for each OTS see the RCT User Manual.)



10 In essence, RCT’s Limits dynamically modify any OTS to match each piano’s 
scale. That’s why many RCT users use one OTS on most of their residential 
(non-concert) pianos. We suggest you do the same for your first few short-scale 
pianos. Then if you decide you want to make further modifications, read about 
Custom Equalizer and User Limits in the RCT User Manual. 

Saving tuning records and files
We recommend you don’t save tunings for at your first few dozen tunings, 
especially if you’re new to computers. This will help you concentrate on learning 
to tune with RCT. After you’re comfortable with RCT, you may want to save 
tuning records and re-use it the next time you tune that piano.

Why save tuning records?
1. To save time (about 2 minutes) on subsequent tunings because you don’t 
have to sample notes in Ch3.

2. To insure a piano is tuned exactly the same every time (increases stability).

3. If a room is too noisy for recording good samples in Ch3, you can open a 
saved tuning record created under quieter circumstances. (CyberEar is much 
more tolerant of noise than Ch3.)

To save a tuning record in Advanced Mode
Easy Moders can save records and files too! After clicking the Calculate 
button, select Tuning Chart in the Windows menu and proceed as below.
After clicking Chameleon’s Calculate button, a tuning chart will open. The 
Predicted Beat Rates for that piano will be displayed in the header. Double-click 
in the header’s empty space to select it, then type the desired name for this 
record (typically, piano model and/or customer name). Stop typing before the 
Predicted Beat Rates run off the right edge of the header box.

Select Save under the File menu. If a tuning file is already open, the new tuning 
record will be saved as the last record in that tuning file. If no tuning file is open, 
a new tuning file will be created and you’ll be asked to name the file. 

Tips on saving files and records
To insure optimum accuracy when Fine Tuning, re-use a saved tuning record 
only on the exact same piano. For Pitch Raising, a same-model piano is 
probably close enough (any piano of similar size or scale may be OK for rough 
pitch raising).

A tuning file holds up to 240 tuning records. A tuning file appears on your 
desktop or window just like other computer files. To organize your tunings most 
efficiently, save many tuning records in a few tuning files. 

The best way to save a tuning record in a desired tuning file is to open the 
tuning file before clicking Ch3’s Calculate button. The new tuning record 
will automatically be placed at the end of the open tuning file.
The Sort command (Tools menu) alphabetizes tuning records in an open tuning 
file using the text in the header. That’s why the first word of a tuning record’s 
name should probably be the customer’s last name or the piano model.

Hot tip!



11Naming tuning files intelligently can help you stay organized. You may want to 
use the 26 empty tuning files RCT creates for you (A through Z) or create your 
own (e.g., Customers A-F, Customers G-R, etc, Piano Library, Concert Hall, 
University Practice Rooms, Steinways, Yamahas, etc.). Suggestion: create       
one called Research for messing around or storing records from weird pianos. 

To move tuning records from one file to another, open the first file, select the 
Tuning Hammer pointer (View menu), click on a tuning record to select it, use 
the Edit menu commands Cut or Copy, open the second tuning file, click in the 
desired location, and use the Edit command Paste. (You can also cut and paste 
multiple tuning records or move records within the same tuning file.)

The Find command (Tools menu) searches for text in the headers of all tuning 
records in an open tuning file (not all tuning files). Hint: Every piano’s serial 
number is virtually unique, so including it in the header insures you can find a 
tuning record that exactly matches a particular piano.

Opening a saved tuning record 
If your hard disk contains tuning records that have been previously created and 
saved (for example, if you purchased a Tuning Library from us or after you’ve 
saved some tunings yourself), you can open a saved tuning record instead of 
creating a new one. 

To open a saved tuning record
Pull down the File menu, select Open File, and open a tuning file. 

To select often-used tuning files, use Open Latest under the File menu.

Files can be viewed as Icons or Headers (View menu). Icon view takes up less 
space, puts only the first letter of a record inside a small piano icon, and lets you 
view a record’s header by placing the pointer over a record. Header view displays 
each record’s complete header in a scrolling window. 

To open a tuning record, click on it with the Magnifying Glass pointer. If using the 
Tuning Hammer pointer, press the Command (Mac) or Control (Win) key when 
clicking.

Then select CyberEar using one of the following methods:

Click the CyberEar button in the tuning chart window.

Pull down the Windows menu and select CyberEar.

Press the Return or Enter key.

Demo Pianos
Ch3 permanently stores samples for five Demo pianos: Wurlitzer spinet, Everett 
console, Kawai UST 7 studio, Yamaha C3E 6’ grand, and Steinway D 9’ grand. 
Demo pianos are very convenient for calculating tunings for pitch raising or 
research (not recommended for Fine tuning). 

To choose a Demo piano, click the Demo button, select a Demo piano, then 
click OK. The Variance numbers will all be 0.00 (Easy Mode will display “Demo” 
variance.) Click the Calculate button to calculate a tuning record. The name of 
the Demo piano will automatically appear in the record’s header.



12
Pitch Raising tips for Advanced Users
The graph below shows the standard overpull percentages RCT uses when 
calculating pitch raises. The overpull percentages jump from 14% to 32% at the 
break between wound and plain-wire strings, which is why you enter the lowest 
plain-wire note into the Pitch Raise dialog box. In the example graph below, the 
lowest plain-wire note is C3, which of course will vary from piano to piano.

In the Pitch Raise dialog box you can choose various settings such as:

Adjust the overpull percentages up or down by 5% in increments of 1%. You 
can also create a Custom Overpull percentage chart (see the User Manual 
for details).These features are cool because they can help make your pitch 
raises more accurate in unusual situations. For example, weakly built spinets 
sometimes require more overpull and strongly built grands may need less 
overpull; some tuners don’t set tuning pins when pitch raising so might prefer less 
overpull; or you might like leaving pitch raised pianos sharp of 440 and therefore 
prefer more overpull.

Select pitch raise type. Small is for pitch raises of less than 60¢, Medium for 60¢ 
to 100¢, and Large for 100¢ or more. (Large pitch raise mode doesn’t sample 
each note.)

Set caps (limits) for cents overpull in the bass and treble. This helps prevent 
string breakage if the strings are rusty or weak and the piano is substantially off 
pitch.

You can also set a different Spinner rate and color for Fine Tuning and each Pitch 
Raise mode. Select a tuning mode, click the Spinner button, choose the desired 
settings, then click OK. For example, you may wish to set the Spinner rate to a 
less sensitive setting such as 4 or 8 cents per revolution per second to help you 
tune pitch raises quickly. However, pitch raising with RCT is so accurate it can be 
regarded as a fine tuning under many circumstances (e.g., pitch raises of 10¢ or 
so) which is why many of us leave Small Pitch Raise mode to the same Spinner 
rate as Fine Tune (albeit a different color).


